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This is the Main Menu screen of Piano Professor.    From this screen you can navigate through the entire 
program. You simply move the mouse cursor over the selected topic on the Main Screen and when your 
choice appears lit in red simply double click the mouse and you will be in that section of    the classroom 
and Piano Professor will be ready to begin teaching you. 

You may also make selections and other choices from the menu options.



Whats New In Version 2.5!

With the overwhelming response we have received in orders and new suggestions and ideas we have 
dramatically improved Piano Professor with version 2.5.    This new release is because of all the 
honest users who have registered their copy of the product.    Keep sending in those ideas and orders
as we will continue to pursue an even better product that meets your learning needs.    We would like 
to thank those users who have taken the time to register their product and all those registered users 
will receive the free upgrade to this new version 2.5 of the Piano Professor.    

We chose to release this as a new version simply because of the many changes and additions that were 
instituted.    The enhancements include the following:

¨ Our artist has been hard at work to make the virtual keyboard appear as realistic as possible.    
You will see this change in the Note Tutor and Name that Note.

¨ Hands Free Interaction on Note Tutor and Name That Note.    Now your hands dont have to leave 
your MIDI Keyboard.    Generate a new note by simply pressing Middle C on your keyboard.    Also
there are no more annoying message boxes, now infomration is displayed right on the screen.

¨ Note Tutor now has the option of sticky keys or not, play with it see which you like better.

¨ The Key Signature screen has undergone a facelift and now looks a lot better plus it reduced the 
size of Piano Professor.

¨ We added 3 new chords to the Chord Encyclopedia, Major 7 Flat 5, 9 and Major 9.    If you want 
even more, let us know!

¨ Name that Note has a cool new feature.    Lets face it guessing a note by ear is hard enough (for 
those of us without perfect pitch).    Now you learn to progressively identify notes.    That is you 
can choose the notes you want to randomly generate.    For example you can concentrate on 
being able to hear say F# and C without the sounds of other notes interfering.    Then once you 
have mastered C and F#, you can add A, etc.    This method of progressive learning should be a 
great help!

¨ We fixed the security screen so that it is not such a pain to type in the registration number (hint, 
hint).

Added in Version 2.0 (Just so you know!)

¨ Ability to play sound through the PC speaker.    This allows those of you without sound cards to till
hear and enjoy the Piano Professor.

¨ Some people had problems with the MIDI Mapper being a requirement.    This was fixed so that 
the Piano Professor will now correctly identify and use other ports.

¨ We added the ability to RECORD and PLAY your lessons in the Note Tutor.    

¨ The Note Tutor has some new game fun added.    You can race against the clock in your attempt 
to identify or guess the notes.



¨ At the request of our European users we have added the ability to see the Solfeggio notation in 
the Piano Professor.

¨ The problems that occurred in the installation program are now completely resolved.

What is Next?

¨ Goodbye 16 bit, Hello 32 but...Look for speed and enhancements...any ideas out there?



Other Information

In case you would like to get the shareware version of the product on diskette or tell others where to pick 
up a shareware copy of the product, you may contact any of the shareware distributors out there.    In 
particular a great shareware vendor with lots of other way cool products in their catalog is Reasonable 
Solutions.    You may reach them at:

Reasonable Solutions
1535 E. University Drive
Mesa, AZ 85203-8132
Phone: (602) 668-0017
Orders: (800) 876-3475
Fax:          (602) 668-9429

Comments

This product would not be possible without the effort of our team.    We would like to take the time to thank
both the Author and the team of people who helped bring this product to reality and the continuos effort of 
Daryl Pietrocarlo    to keep taking his vision further. To see just why this program was created please see 
the Authors Note. We would also like to thank all our    registered users out there for their help and new 
ideas.    Please keep sending them in and we will continue to enhance the product and try to make it do 
the most for you.

We are currently working    out arrangements with distributors in the various countries around the world 
since Piano Professor has made its way to over 20 countries.    We would like to say Thank You to our 
friends in Europe, Asia, and way down under in Australia.    Also a big hello and Thank You to our friends 
in far off places we have never heard of before, but now recognize.    You are all on our giant world map 
that shows just how far and how widely received Piano Professor has been.    Look for some new fun and 
exciting products to arrive January 1996.    We have some way cool games and other goodies getting 
ready to launch!    The best place to see what is happening is to check out our World Wide Web Page 
located at:

http://www.servtech.com/public/stmm/



Note Tutor

The Note Tutor was designed to    help the user learn how to identify notes on the musical staves in 
relation to their position on the keyboard.    The screen employs several different methods to help the user
obtain this goal. The Note Tutor screen is comprised of several controls that allow easy operation by 
individuals of all ages and skill levels.    The Top half of the screen contains the musical staves with both 
Treble and Bass levels.    The lower portion of the screen contains the keyboard and the controls for 
different learning experiences.    

The user opens the screen and selects the new note button which will randomly display different notes on
the graphical staves without giving the note name to the user. The notes will only be displayed for the staff
that is active.    The user can attempt to guess the note without the help of the computer, but if it becomes 
necessary, the Eye/Ear   button   can be pressed and the name of the note will be displayed in the box next 
to the Eye/Ear button.    The note will also be displayed in red on the graphical keyboard below the 
staves.    As you keep practicing, the recognition of notes will become easier and easier until you are able 
to identify the notes without using the help button.    Once you have mastered this concept, the ability to 
read music and play the notes on the real keyboard will be much easier.    This concept can also be 
reversed, in so far as the user can press the keys on the graphical keyboard, and the note will be 
displayed on the proper staff.    You will visually see the cursor change when a keyboard note is playable.  
Any note above and including middle C will be displayed on the Treble clef, and any note below middle C 
will be displayed on the bass clef. 

The Controls for Note Tutor

You will have complete control of your learning experience by simply using the controls illustrated here.    
These controls    allow you to switch between Treble and Bass; toggle Play mode or Guess mode; 
generate a new note; and hear and see the note illustrated both on the keyboard and the music sheet. 

 New Note button

This button will randomly generate notes on the currently selected staff. This allows the user to guess the 
note in his or her head, or to try and guess the note by pressing keys on the keyboard.    If you have 
trouble guessing the note, you can press the Eye/Ear button at any time to receive the answer.    By using
this method, the user will become more and more proficient at reading and identifying the notes.    

 Eye/Ear button (Show and Hear)

This button allows the user to obtain help, by sight and sound, on the note shown on the currently 
selected staff.    The selected staff is shown by the Staff   button  .    If the user cannot identify the note and 
wishes to use the computer for help, this button will display the key on the graphical keyboard below the 
staff in red that corresponds to the note.    The name of the note will also be displayed in the Note 
Information box.    If sound is available, the note will be played.



    

 Staff button

This button identifies the active staff. When you press the New Note button, or the Eye/Ear Button, the 
information displayed, whether it be a new note or information on that note, will be related to the note on 
the staff displayed on this button.

The Staff button is a toggle button.    When the button says Bass on it, and has the Bass clef symbol, the 
New Note button (shown above) will only produce notes that fall into the Bass range (middle C and 
lower).    Pressing the button once will toggle you into Treble mode. This allows you quick access between
the two modes.

 Play/Guess button

This set of buttons allow the user to switch between attempting to guess a note on the staff and playing 
the keyboard and seeing the notes appear on the staff.    In Play Piano mode the notes pressed on the 
keyboard on the screen or a MIDI keyboard attached to the computer are displayed on the staves.    In 
Guess Note mode a note will appear on the staves and the user is expected to press the appropriate key 
on the screen or with the MIDI keyboard.

In addition to all of this, the user can press any of the white keys on the keyboard to simulate playing the 
keyboard.    When the key is pressed, the note is lit up in red, the musical note is played (if there is sound)
and the note name is displayed in the Note Information box.

The Option Menu

The option menu contains a few entries that are explained below.

Record/Play - allows you to record a sequence of keys, and then play them back.

Sticky Keys - The default behavior when a key is pressed is to see the key lit in red, this is what is 
considered a sticky key.    By deselecting this option, the key will remain red only as long as you hold the 
mouse button down on that key.

Demo Fur Elise - This option will cause Piano Professor to play a rendition of Beethovens Fur Elise.

Guess Timer - Will bring up a dialog box that allows you to set an option to attempt to beat the professor. 
By setting this option to a certain number of seconds and putting the Note Tutor in Guess Note mode, you
will have to guess the new note in under the number seconds you entered.    For example, if you entered 
7 seconds and put Note Tutor in Guess Note mode, after pressing the New Note button, you will have 
seven seconds to guess the note before Piano Professor guesses it for you!



Chord Encyclopedia
The chord encyclopedia is a reference to different chords.    It allows the user to pick the key, chord name 
and inversion.    Once the user chooses all the options, the View Key will enable them to see and hear the
chord (if sound is available).    The keys will be highlighted in red.    The user will also hear the chord 
played if a sound device has been installed.

 Chord Selection box

By using the above control box the user can drop down a menu of the available keys to select the chord 
from.    The user can also change the chord that is to be displayed in the same manner.    The available 
keys are: C, D flat, D, E flat, E, F, F sharp, G, A flat, A, B flat, B.    The available chords are: Major, Minor, 
6, 7, Major 7, Minor 7, Dim, Dim 7, Aug, Aug 7, Sus 4, Minor 7 Flat 5, 9,    Major 9.

Explanation of Chords

A major chord is a three key chord called a triad.    The triad contains the first, third and fifth notes of the 
scale that the chord is in.    For the key of C, these notes would be C, E and G (at root position).

A minor chord is similar to a major chord, but with the third note of the scale lowered a half step.    In the 
case of C, the third note of the scale is E, therefore if you lower this note a half step it will result in E Flat.   
So the a C Minor chord would be C, E Flat, G.

A seventh chord is comprised of the major chord and the seventh note of the scale one half step lower.    
As an example, the seventh note of the C scale is B.    To get the seventh chord play the triad plus the 
seventh note minus a half step.    In this case, a half step lower would be a B flat.    Thus the notes for a 
C7 would (root position) would be C, E, G and B Flat.

For further information on types of chords, refer to any book on musical theory.

 Chord Inversion box

Chord Inversions are simply a different way to represent a given chord.    The root position has as the 
first key, the first note, the name of the key corresponding to the chord.    So for the chord C major, the key
C on the piano would be in the root position.    The first inversion has the third note of the scale as the first
position, and the second inversion has the fifth note of the scale in the first position.    For C major - First 
Inversion, the first key in the triad would be E followed by G and C, and for the second inversion, the first 
key in the triad would be G followed by E and C. 

 Eye/Ear button (Show and Hear)

This button allows the user to obtain help, by sight and sound, on the chord and key combination shown 
in the Chord Selection box.    The selected Chord, Key and Inversion are shown on the graphical 
keyboard with a red highlight.    Below the graphical keyboard the chord name will be identified.    If sound 
is available, the chord will be played.



Key Signatures
The Key Signature screen will help the user to identify all the different key signatures.    A key signature is 
shown at the beginning of each bar of music. It tells the musician what key the music is in. 

The key is determined by the composer, when she or he decides that a particular note will be flatted or 
sharped throughout the entire piece without further instruction.    The symbols may be either flats or 
sharps., they are never mixed. This tells the reader of the music    what to do when they see that note in 
the music.    If the symbol is on that note in the key signature, and the user is now playing that note,    the 
musician must play that note either flatted or sharped, depending on the symbol.

A flat implies that the player lowers the note a half step. Therefore, if the key signature shown is in the key
of F, that is, there is a flat symbol on the B note of the staff, every time the player sees a B in the music 
he/she should play a B Flat.    

The same goes for sharps, except that you must raise the note a half step.    Therefore, if the key 
signature shown is in the key of    G, that is, a sharp symbol appears on the F note of the staff, every time 
the user sees an F in the music, they should play F sharp.    It is very useful to the musician to be able to 
recognize the keys at a glance, and be able to comfortably play in these keys without much thought.    By 
learning to recognize these keys quickly the player will be able to play more music with more proficiency.



Name That Note

This screen can be used to train your ear to recognize notes based solely on their sound.    The computer 
will play a note for you, it up to you to guess the correct note.    By Pressing the New Note button, the 
user can have the computer play a new note.    The computer will play a note in the range designated by 
the Range of Notes to Generate selection.    The Ear button will allow you to hear the last note played by
the computer.      The Generate Only listbox allows you to choose only those notes you wish to generate.  
This is a excellent option because it allows you to limit the notes generated by the program, thus enabling
your ear to distinguish between the sounds of only specific notes.    In this way you can concentrate on 
being able to hear say F# and C without the sounds of other notes interfering.    Then once you have 
mastered C and F#, you can add A, etc.    This method of progressive learning should be a great help!

As you continue to try an guess different notes, the computer will keep track of you progress by displaying
you current statistics. It will tell the number of notes you have guessed since you entered the Piano 
Professor, or since the last time you cleared the score by using the Reset Score menu option.    The 
computer will also record the number of times you have tries to guess the current note.    The Average 
Number of Guesses is a running average which is computed by the total number of guesses divided by 
the number of correct notes guessed.

HINT:
If you are really struggling trying to guess the note, you can obtain the answer by placing the mouse 
cursor over the ear button and pressing the RIGHT mouse button.    Remember that this method does not 
contribute to your overall statistics.

The Controls for Name that Note

 New Note button

This button will randomly generate notes over the selected note range. The user will then attempt to 
guess the note by pressing keys on the keyboard.    The computer will then keep a record of incorrect 
guesses and average out the number of guesses per note    If you have trouble guessing the note, you 
can press the Ear button, with the right mouse button, at any time to receive the answer.

 Ear Button

The Ear button will allow the user to hear the current note again.    This button may be pressed as many 
times as necessary.    If you should get stuck on a given note then you can click the Ear button with the 
right mouse button to receive the answer.

 Range button



The Range button will allow you to decrease the number of notes that Name that Note can randomly pick. 
If the Range button is set to Middle C and Higher then the note that is generated is within the range of 
Middle C and Higher.    If the Range button is set to Middle C and Lower then the note that is generated is 
within the range of Middle C and Lower.    The last option, Entire Range, will not limit the scope of notes 
that can be picked.    It is advisable to choose a limited range of notes before trying to use notes from the 
entire range.



Great Staff
The Great Staff is a reference screen designed to show the user the notes names at the positions on both
the Treble and Bass clefs.    It is used to help the user identify what note is a specific position on either of 
the staves.    What is nice about this screen is that it gives a pictorial and full representation of both 
staves, and the user can see all the note names on one screen.

This screen can be brought up from any other screen in the product.    It comes up as a reference screen. 
What this means is that the screen is no meant to have interactive capabilities.    When the user is done 
using this screen, he or she should press the Done button to close the screen and return to the base 
screen from which they brought up the Great Staff screen.



Keyboard Screen

The Keyboard screen explains the different parts of the piano keyboard, as well as some of the notation 
used on a piano keyboard.    If you ever wondered what a sharp or flat was, or why there are white and 
black keys, this is the screen for you to use!



Using the Piano Professor is simple and easy.    Descriptive pull down menus allow you to navigate your 
way through the product quickly and easily. 

The File menu option

The File option contains the following sub options:

Music On will allow you to turn the music on or off system wide.    If there is a check mark next to 
the option, the music will be turned on throughout the product.    If there is no check mark next to 
the option, the music will be turned off throughout the system.

Register Software will allow you to register this product with SofTech Multimedia Inc. Registering
the software has many advantages, see the section on Product Registration.    This option will not 
appear if the product is registered.

The View menu option

The View option allows you to change to any screen on demand, simply pull down the menu and 
select the screen that you wish to go to.    The Great Staff screen will come up in a view only 
mode.    This means that the user uses the screen as a reference, and closes it when he/she is 
done using it.    There is help for all the screens contained in the product.    The help will aid the 
user in using the screen he/she is on.

The Help menu option 

Under the Help menu option, you will find the different help options that allow you access different
types of help.

Help on this Screen will give you access to help that pertains to the specific screen that you are 
on.    This will enable you to quickly access help about the screen that will give you help and tips 
on how to use the screen.

Contents will take you to the Help Table of Contents which includes all the major topics in the 
help file.    From here you can just click on the highlighted topics and you will jump directly to the 
help topic that you just pressed.

Search for Help on... will allow you to search for help on any of the specific topics in the help file.
You can search for topics by typing the key words into the search box that comes up.    When you 
have found the topic that you wish to go to, you can press the Show Topics button,    from there 
you can press the Go to button to go to the help screen for that topic.



About Piano Professor explains what version of the Piano Professor you are running, how to 
contact SofTech Multimedia Inc. , as well as registration and system information.    The system 
information is a useful tool that will determine you system hardware as well as you currently 
installed multimedia devices.
Technical Support is an easy way for you to find out how to contact SofTech Multimedia Inc. for 
any technical support, registration information or orders for new products.



Reference Information

The chord encyclopedia is a reference to different chords.    It allows the user to pick the key, chord name 
and inversion.    Once the user chooses all the options, the View Key will enable them to see and hear the
chord (if sound is available).    The keys will be highlighted in red.    The user will also hear the chord 
played if a sound device has been installed.

Explanation of Chords

A major chord is a three key chord called a triad.    The triad contains the first, third and fifth notes of the 
scale that the chord is in.    For the key of C, these notes would be C, E and G (at root position).

A minor chord is similar to a major chord, but with the third note of the scale lowered a half step.    In the 
case of C, the third note of the scale is E, therefore if you lower this note a half step it will result in E Flat.   
So the a C Minor chord would be C, E Flat, G.

A seventh chord is comprised of the major chord and the seventh note of the scale one half step lower.    
As an example, the seventh note of the C scale is B.    To get the seventh chord play the triad plus the 
seventh note minus a half step.    In this case, a half step lower would be a B flat.    Thus the notes for a 
C7 would (root position) would be C, E, G and B Flat.

Chord Inversions are simply a different way to represent a given chord.    The root position has as the 
first key, the first note, the name of the key corresponding to the chord.    So for the chord C major, the key
C on the piano would be in the root position.    The first inversion has the third note of the scale as the first
position, and the second inversion has the fifth note of the scale in the first position.    For C major - First 
Inversion, the first key in the triad would be E followed by G and C, and for the second inversion, the first 
key in the triad would be G followed by E and C.



Registration

Registering via U.S.     Mail  
 

Registering via CompuServe

Registering via World Wide Web

 Registering via Telephone

Benefits of Registering



U.S. Mail Registration
You may register your copy of Piano Professor for Windows by printing the registration form. If 
you do not have a printer you may copy the information from the screen. 
 
The cost of Piano Proferssor is $24.95 and New York State residents please add 8% sales tax. 
There is a shipping and handling fee of $4.00 for U.S. and Canadian residents and $6.00 
outside the U.S. Enclose your check or money order (drawn on U.S. funds) for the computed 
sum on the registration form    and made payable to SofTech Multimedia, Inc. Mail your order to: 

SofTech Multimedia, Inc.
79 Springfield Avenue
Rochester, NY 14609-3607
Phone: (716) 288-5830
Fax:          (716) 482-7105

The day    we receive your order we will ship your 3.5 diskette(s).    

You will also receive your registration serial number that will make your copy of Piano Professor 
for Windows a registered copy.    You will also be eligible for a free update on the next version of 
the product.

    



Registering via CompuServe

Electronic orders may be placed with CompuServe Information Services. The amount of $34.95 
will be billed directly to your CompuServe statement for your convenience.    This covers all 
shipping and handling charges as well as applicable sales tax.      Just type GO SWREG and 
request SofTech Multimedia, Inc.      Our SWREG ID is 2862.

We receive confirmation of your order from CompuServe within a couple of hours.    We will 
process your letter of authorization, official diskettes, and security ID and place it in the U.S. 
Mail within 1 day of your order.    We will mail you, via CIS mail, your security ID, within 24 
hours, so that you can remove the end registration reminder and gain access to all of the 
programs features.



 Registering via Telephone

You may register your copy of Piano Professor for Windows using MasterCard, Visa, American 
Express, and Discover Card.    This is a service provided by Public (software) Library which we 
will be using as our distributor for credit card orders.      You may contact PsL at (800) 242-4775. 
You will need to specify the Product Number: 11334 for Piano Professor. PsL operates from 
9:00am - 6:00pm Pacific Time    Monday trhough Friday. For residents outside of the United 
States or for those that cannot reach PsL at the 800 number, here are some alternative 
numbers:    

Toll Number: 713-524-6394
 Fax Number: 713-524-6398

You may print    the Credit Card registration form if you desire to mail or fax in your credit card 
order.    

Please note that the above numbers are for credit card orders only. Any questions about the 
status of the shipment of the order, refunds, registration options, product details, Technical 
Support , volume discounts, educational discounts, dealer pricing, or site licenses should be 
directed to SofTech Multimedia, Inc.    PsL cannot provide you with order status or any of the 
other aforementioned items.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship 
the product directly to you.



Benefits of Registering

You may have noticed that the Piano Professor has certain limitations built into it for non-
registered users.    By registering the product, you can unleash its full potential.    We have tried 
only to limit the more advanced features while still providing you enough opprotunity to explore 
and use the product and try before you buy.    The following will illustrate what you will gain from 
registration:

 You will receive a registration serial number and password along with 2 official diskettes with 
the latest version of Piano Professor. You will also be eligible for a free upgrade to the next    
revision.

 The Note Tutor screen will allow you to play the entire piano, instead of just one octave.

 
 You will be able to access all the chords on the Chord Encyclopedia    rather than just Major, 

Minor and Sixth chords.    

 On Name that Note you will get the benefit of reducing the notes generated by the computer 
to only half of the keyboard instead of the entire range.    

 Another advantage of registration will be the ability to see all the key signatures instead of a 
restricted set on the Key Signature screen.    

 You will receive 90 days of free technical support.

 Finally, registration of the product will help all of us at SofTech Multimedia Inc. pay our 
bills, eat, and bring you more great software at affordable prices.



Order Form for Piano Professor for Windows (latest version).
(Check or Money Order)

If you have a printer you may print this form by selecting Print Topic from the File menu.    For 
those without a printer you may copy this information on a sheet of paper.

Enclose your check or money order (drawn on U.S. funds) for the amount of $24.95 per copy    
and made payable to SofTech Multimedia, Inc. New York State residents please add 8% sales 
tax ($26.95 sub-total). There is a shipping and handling fee of $4.00 for U.S. and Canadian 
residents and $6.00 outside the U.S.    Please Mail to:

SofTech Multimedia, Inc.
79 Springfield Avenue
Rochester, NY 14609-3607
Phone: (716) 288-5830
Product Code for Piano Professor for Windows is: 11334

Your Name:________________________________________________________

Address: _________________________________________________________

Address:__________________________________________________________

City:_____________________________________________________________

State/Province:___________________________________________________

Zip/Postal Code:__________________________________________________

Telephone:________________________________________________________

E-Mail Address:(if applicable):___________________________________

Desired Features, Questions,Comments:_____________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________

Number of Copies:____________ X $24.95 = _________________
NY Sales Tax(if applicable) @8.00% =                    __________________
Shipping & Handling (see above)            =                    ___________________

Total:             ___________________

Thank you for your support!



Order Form for Piano Professor for Windows (latest version)
(Credit Cards Only)

If you have a printer you may print this form by selecting Print Topic from the File menu.    For 
those without a printer you may copy this information on a sheet of paper.

The amount of $24.95 and made payable to SofTech Multimedia, Inc. New York State residents 
please add 8% sales tax ($26.95 total).      There is a shipping and handling fee of $4.00 for U.S.
and Canadian residents and $6.00 outside the U.S.

This form is for credit card orders such as MasterCard, Visa, American Express, or Discover 
Card.    You may Email this completed form by CIS Email to 71355,470. You may also FAX or 
Mail this completed form as well.    Please fill out the form completely and be sure to sign the 
signature line. Please    Fax(24 Hours a day/7 days a week) or Mail to:

Public (software) Library
P.O. Box 35705
Houston, TX 77235-5705
FAX: (713) 524-6398

Product Code for Piano Professor for Windows is: 11334

Your Name:________________________________________________________

Address: _________________________________________________________

Address:__________________________________________________________

City:_____________________________________________________________

State/Province:___________________________________________________

Zip/Postal Code:__________________________________________________

Telephone:________________________________________________________

E-Mail Address:(if applicable):___________________________________

Credit Card Type:______________________________________________

Name as it appears on Credit Card:__________________________________

Expiration Date of Credit Card:______________________________________

Credit Card Number:_______________________________________________

Signature of Card Holder:___________________________________________

Desired Features, Questions,Comments:_____________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________



Number of Copies:____________ X $24.95 = _________________
NY Sales Tax(if applicable) @8.00% =                    __________________
Shipping & Handling (see above)            =                    ___________________

Total:             ___________________

Thank you for your support!



Registering via World Wide Web

You may register your copy of Piano Professor for Windows using 
MasterCard, Visa, American Express, and Discover Card on the World Wide 
Web.    This is a service provided by Public (software) Library which we will be 
using as our distributor for credit card orders.      You can get to the Web 
Registration form by setting your Web Browser to:

http://www.servtech.com/public/stmm/

Once there look for the link that says REGISTER NOW.    This will give you the 
order entry screen that you simply fill out and submit.    PsL will notify us of your 
order and your product will ship in 24-hours.    If you want your passcode issued 
via electronic mail, please put your email address on the order form.    

You may print    the Credit Card registration form if you desire to mail or fax in your credit card 
order.    

Please note that the is for credit card orders only. Any questions about the status of the 
shipment of the order, refunds, registration options, product details, Technical Support , volume 
discounts, educational discounts, dealer pricing, or site licenses should be directed to SofTech 
Multimedia, Inc.    PsL cannot provide you with order status or any of the other aforementioned 
items.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship 
the product directly to you.



Trouble Shooting Guide

The following section should be consulted before calling SofTech Multimedia, Inc. for technical support.    This 
section is intended to provide questions and answers to the most common problems with Piano Professor for 
Windows.    If you are having a problem with the software that is not covered in this section then see the section 
titled Technical Support .

Q:    When first starting Piano Professor for Windows I receive a MIDI Sequencer error message like the following:

A:    The above message is not an error message but an informational message.    The message is stating that your 
sound card may not be able to correctly sequence MIDI sounds.    You can disable the message by clicking on the 
box: Don't display this warning in future.

Q:    Why do the colors in the Piano Professor look funny?

A:    The Piano Professor for Windows uses 256 color graphics.    If the colors are funny on your system then you 
are using a video resolution with less than 256 colors.    The Piano Professor will run correctly with less than 256 
colors but the color graphics on the opening screen and in other places will look funny.    The way to fix this is to use
Windows Setup to change the current video resolution to one with at least 256 colors.    Please refer to your 
Windows manual for information on how to change the video resolution with Windows Setup.

Q:    Why doesent the sound play on my system?

A:    Sound may not play on your system for a number of reasons.    The first and most obvious is do you have a 
sound card installed on your system.    If there is a sound card in your system then check to see that the sound drivers
(supplied by the cards manufacturer) are installed correctly.    If both of the above things are checked and OK then 
attempt to play the file OPENING.MID from the PIANPROF\SOUND directory using the media player.    If the 
sound does not play with the media player then you do not have your MIDI mapper set correctly for your sound 
card.    Check the MIDI Mapper in the control panels to see that your MIDI settings are valid and are not set to 
NONE.

General Sound Info and Helping Us to Help You

Your sound card must have MIDI capabilities.    Most of the 
sound cards on the market (ie. Soundblaster and Sound/FX) 
are able to support MIDI.    If you are unsure, please check
your owner's manual.    

If your sound card meets the above specifications and the
Piano Professor is still not playing sound, or is presenting
the MIDI error message...

A.    Make sure that the MIDI Mapper drivers are installed



        correctly.    This can be checked easily by using the 
        Media Player shipped with Windows, and attempting to
        play a MIDI file through the MIDI Sequencer.    A Valid
        MIDI file was shipped with Piano Professor.    It can be
        found in the "sounds" directory under the directory in
        which you installed Piano Professor.    The file name is
        "opening.mid".

If Method A does not work, consult the Windows documentation, or your sound card manual for proper 
configuration.    

If the file plays through the Media Player as in Method A...

B.    Check the MIDI Mapper Setup as follows:

1. Go into Control Panel
2. Click on MIDI Mapper
3. Press the "Edit" button

You should see the following heading:

Src Chan    Dest Chan      Port Name        Patch Map Name      Active
----------------------------------------------------------
 1                1                      (Sound              [None                          [X]
                                              Card                    -or-
                                              Dependent)      User selected
                                                                        patches

 2                2                        "                        "                                  "
 .                .                        "                        "                                  "
 .                .                        "                        "                                  "
16                16                      "                        "                                  "

Make sure that all of the "Port Names" are filled with the
appropriate port (ie. mine says "SB Pro 2 Synth").    Especially 
channels 10-16, since these are the channels that seem not to 
get configured properly during setup.

---------------------------------------------------------------

The program checks to see if there are MIDI OUT devices present in the Windows system configuration.    If it finds 
them, it attempts to open this device for reading so that the MIDI keyboard can be read in.      If NO MIDI OUT 
DEVICES are found, the system does not attempt to open the port.

It is helpful if we have what Piano Professor beleives to be your system configuration.    Here is an easy way to 
obtain your system configuration.

1. Click on the "Help" menu at the top of your Piano Professor Screen.
2. Choose "About Piano Professor".    The Piano Professor "About" screen should appear.
3. Click on the button that says "System Info"
4. Choose "Multimedia Information" from the drop down list above the information area.
5. Click on the "Save" button.
 6. Send this information back to SofTech Multimedia, Inc. 





    Musical Terms

Used to Indicate Tempo
Used to Indicate Change in Tempo
Used to Indicate Volume of Sound
Used to Indicate Change in Volume of Sound
Used to Indicate Simultaneous reduction of Tempo & Volume 
Used to indicate Mood, Degree, Intensity, or Style 



Musical Terms that Indicate Tempo

Slow

Lento Slow
Largo Broad
Adagio At ease, slow, drawn out
Grave Heavy, serious
Larghetto Not so broad as Largo

Medium

Andante Medium slow
Moderato Moderate
Allegretto Less fast than Allegro
Andantino Less slow than Andante

Fast

Allegro Fast
Vivace Lively
Presto Very fast
Vivacissmo Livlier than Vivace
Prestissimo Even faster than Presto

-ino, -etto: The suffix, -ino or -etto, added to one of the tempo indications weakens 
or implies less quality of the original term.

-issimo: The suffix, -issimo, added to one of the tempo indications intensifies the 
quality of the original term.

non troppo Not too______(fast or slow)



Musical Terms that Indicate a Change in Tempo

Accerlerando Getting faster
Stringendo Rushing
Ritardando Slow down, hold back
Rallentando Slowing down
Allargando Getting broader
Ritenuto Held back
Piu More
Meno Less
Piu mosso Faster
Meno mosso Slower
A tempo In tempo
Tempo Primo First tempo
Listesso tempo The same tempo



Musical Terms that Indicate Volume of Sound

Forte (f) Loud
Piano (P) Soft
Fortissimo (ff) Very loud
Pianissimo (pp) Very soft
Mezzo forte (mf) Medium loud
Mezzo piano (mp) Medium soft

Levels louder than ff are indicated by adding additional f s:
fff ffff

Levels softer than pp are indicated by adding additional p s:
ppp pppp



Musical Terms that Indicates a Chnage in Volume of Sound

 Crescendo Growing louder
Decrescendo Growing softer
Dimenuendo Growing softer
Forte piano (fp) Begin the note loud, but drop it to soft 

immediately
Sforazando, sforzato (sf, fs, sfz) Forced, accented



Musical    Terms    for simultaneous reduction of Tempo & Volume 
Calando Decreasing
Smorzando Dying away
Morendo Dying down

Qualifying Terms used to indicate Mood, Degree, Intensity, or Style 
Molto Very, much
Poco A little
Un poco A little
Poco a poco Little by little
Piu More
Meno Less
_____ non troppo Not too ______
Non troppo _____ Not too ______
_____ ma non troppo Not too ______
Agitato Agitated
Amabile Affectionately
Animato Spirited, animated
Apassionato Passionately
Cantabile Singing
Con amima With spirit
Con brio With brilliance
con dolore With grief
Con forza With strength
Con fuoco Fiery, with fire
Con moto With movement
Dolce Sweetly
Dolente Grieving
Energico Energetically
Espressivo Expressively
Giocoso Jestingly, playfully
Grazioso Gracefully
Legato Smoothly, slurred
Leggiero Lightly
Lusingando Cajolingly, alluringly
Maestoso Majestically
Marziale Martially
Misterioso Mysteriously
Perdendosi Dying away
Pesante Heavily
Piacevole Pleasingly, agreeably
Portamento Sliding of the voice
Risoluto Resolutely
Scherzando Playfully, jokingly
Sostenuto Sustained
Staccato Short and detached



Teneramente Tenderly
Tenuto Held



Shareware Trade Association and Resources(STAR)

SofTech Multimedia, Inc. is also a member of the STAR. The following is the Mission Statement 
of STAR.    This statement was extracted from STAR.

STAR is a trade association established to provide the shareware community with a vehicle for 
networking, resource-sharing, publicity, and marketing assistance.    STAR will promote the free 
and open exchange of information, creative expression, and quality and ethics in shareware. 
STAR will heighten the public's awareness of shareware, and will advance the state of the 
shareware industry.
Shareware Trade Association & Resources
P.O. Box 13408
Las Vegas, NV    89112

Voice: (702) 735-1980
Fax:        (702) 735-4603 



Educational Software Cooperative

SofTech Multimedia, Inc. is working to produce educational multimedia titles and we are now 
members of the Educational Software Cooperative.    The goals and agenda of the ESC fit into 
the realms of our vision for future software titles.    We hope that as members, we will be one of 
the driving forces into the era of educational software.

Educational software is one of the most popular and fastest-growing categories of software. In 
1992, the Educational Software Cooperative (ESC) was founded by Andy Motes, author of the 
award-winning "School Mom" program.
 
Incorporated in 1994, ESC is a nonprofit organization whose purposes are to advance the 
mutual benefit of authors, publishers, dealers and distributors of educational software; to 
voluntarily cooperate formally and informally with each other to better develop, advertise, 
distribute and sell educational software; and to provide the public with information regarding the 
benefits, uses, and availability of educational software. 

Software users, educators, developers, publishers, distributors, and others
work together to promote these goals.
 
A wide variety of educational software titles for both children and adults are available on a CD-
ROM which can be purchased through many of the Author and Vendor members. We expect to 
produce a new CD approximately every six months.
 
We currently publish a bimonthly newsletter containing articles written by ESC members and 
associates, along with product reviews, tips and suggestions for better ways to write and market
software and discussions of educational issues. In this newsletter, you'll also find a list of new 
program additions and updates.
 
Since June 1993, the ESC has had its own section on CompuServe where its members can 
communicate directly with each other and the public. You can participate in this section whether 
or not you are a member of ESC. Just enter GO EDFORUM at any CompuServe prompt, and 
join us in Section 2.
 



Our activities have included participation in trade association events in Indianapolis and Atlanta. 
We work with other organizations on issues, such as software ratings, that affect the industry as 
a whole.
 
You may contact the Educational Software Cooperative at:
 
          Educational Software Cooperative
          11846 Balboa Blvd, Suite 226
          Granada Hills CA 91344



Registration Benefits
By registering Piano Professor for Windows, you gain the following:

1. Set of registered diskettes - You will receive the latest and greatest release of Piano 
Professor for Windows, on you choice of either a 3.5" (the default), or 5.25" diskettes.      

2. A registration number - which will remove the annoying "SHAREWARE NOTICE" reminder 
screens. 

3. Peace of mind - you have fulfilled your obligation, and have made the Shareware concept 
work.    You are not breaking the law, at least in this particular case!

4. Access to support - If you have problems using Piano Professor for Windows, we are here to 
help you.    Support is guaranteed for 90 days from the date of registration.    If we can't resolve 
your problem to our mutual satisfaction, we will refund your money, as long as the problem is 
brought to our attention within the 90 day time frame.





Technical Support
Registered users of Piano Professor can obtain technical support through either CompuServe or
the Internet by sending mail to our technical support department.    We will provide all registered 
users 90 days of free technical support. Technical support questions should be addressed with 
the subject heading:    Piano Professor Support Needed.    You should mail these to 
CompuServe Account    74043,1703.    For those mailing us from the internet, the address would 
be 74043.1703@compuserve.com. You will receive a reply within 24 hours addressing your 
questions, problems, ideas, and even criticisms.

In order to answer your technical questions you will need to provide us with the following:

Your full name.

Your address.

Your telephone number or e-mail address so we can contact you.

The name of the product.

The product version number.

Your product serial number.
You can obtain the last three items by doing a Help/About in the program and the information 
will be provided to you. 

While we have instituted quality control    and software engineering practices, those little nasty 
critters called bugs may have wandered in at some point.    If you happen to locate and bugs, 
major problems, etc. you may submit bug reports to us through CompuServe, internet, voice 
mail, or regular mail. 

 We have also attempted to test this product on a variety of computers and under various 
conditions, but we cant possibly try every combination, so please feel free to inform us of any 
difficulties that you may encounter, registered or non-registered. If you are reporting a bug, 
please include the following:

An exact description of the problem.

A list of your system's hardware and software.

What you were last doing when the bug occurred

Can you reproduce the bug more then once

In terms of the content.    We have worked with professionals in the music arena for their input 



and suggestions on this product.    If you have any questions or concerns regarding the content 
aspect, such as disagreeing with something as it is stated or presented, please feel free to let us
know that as well.

We welcome any suggestion, criticism, and/or grand ideas that could help make this product 
better.    We promise to take into consideration any reasonable ideas that you may provide.    As 
long as their is enough support and ideas, you can be sure to continue to see new and 
improved versions.    

Contact information:
SofTech Multimedia, Inc.
79 Springfield Avenue
Rochester, NY 14609-3607
Phone: (716) 288-5830
Sales: (800) 624-3197
Fax:          (716) 482-7105
Compuserve: 74043,1703
World Wide Web: http://www.servtech.com/public/stmm
Internet: 74043.1703@compuserve.com 



End-User License Agreement
Shareware. This product is being released as Shareware.    You may use it for a 30 day trial 
period.    If you use it for more then 30 days then you are required to register this product.    You 
may distribute the Shareware version of this product to anyone you wish, so long as all files 
remain and nothing is altered in anyway.    The registered version of this product MAY NOT be 
distributed freely and you must comply with the following Licensing Agreement stated below.    If 
at the end of 30 days you choose not to register the product it must be removed from your hard 
drive.

Sysops and Shareware Distributors.    You may upload, post, or otherwise redistribute this 
product so long as you distribute all files that are in the Packing List; you only redistribute only 
the Shareware(UNREGISTERED) version of this product; that you do not charge a fee except 
for that of a handling and preparation fee which should not exceed more then $5.00 (U.S. 
Currency) per disk.    

License.    You may use the Registered Product    and Disks on any computer, provided that the 
software is used on only one computer and by one user at a time.

Restrictions. You may not commercially distribute the Registered Product Disks or Programs or
otherwise reproduce, publish, or distribute or otherwise use the Disks or Programs in any 
manner that may infringe any copyright or other proprietary right of SofTech Multimedia, Inc., the
Suppliers, or any other party or assign, sublicense, or otherwise transfer the Disks or this 
agreement to any other party unless such party agrees to accept the terms and conditions of 
this agreement.    This license and your right to use the Disks and the Programs automatically 
terminates if you fail to comply with any provision of this agreement.    You may not transfer, 
publish, or distribute your product registration information, nor replicate registered copies of this 
product.    Only the Shareware (UNREGISTERED) version may be distributed freely.

U.S. GOVERNMENT RESTRICTED RIGHTS.    The disks and the programs are provided with 
RESTRICTED RIGHTS.    Use, duplication, or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 
Software Clause at DFARS (48 CFR 252.277-7013).    The Proprietor of the compilation of the 
Programs and the Disks is SofTech Multimedia, Inc., 79 Springfield Avenue, Rochester, NY 
14609-3607.



Product Warranty
Limited Warranty.    SofTech Multimedia, Inc. warrants the physical Disks to be free of defects 
in materials and workmanship under normal use for a period of 30 days from the purchase date. 
If SofTech Multimedia, Inc. receives written notification within the warranty period of defects in 
materials or workmanship in the physical Disks, and such notification is determined by SofTech 
Multimedia, Inc. to be correct, SofTech Multimedia, Inc. will, at its option, replace the defective 
Disks or refund a prorata portion of the purchase price of the software, this does not include any
charges incurred in obtaining or downloading this product nor any shareware distributor fees, 
nor disks obtained from a distributor.    THESE ARE YOUR SOLE REMEDIES FOR ANY 
BREACH OF WARRANTY.

EXCEPT AS SPECIFICALLY PROVIDED ABOVE, THE DISKS AND THE PROGRAMS ARE 
PROVIDED AS IS WITHOUT ANY WARRANTY OF ANY KIND.    NEITHER SOFTECH MULTIMEDIA, 
INC. NOR THE SUPPLIERS SHALL BE RESPONSIBLE FOR ANY CLAIMS ATTRIBUTABLE TO 
ERRORS, OMISSIONS, OR OTHER INACCURACIES IN THE DISKS OR PROGRAMS.    THE ENTIRE 
RISK    AS TO THE RESULTS AND PERFORMANCE OF THE DISKS AND THE PROGRAMS IS 
ASSUMED BY THE USER.    FURTHER, NEITHER SOFTECH MULTIMEDIA, INC. NOR THE 
SUPPLIERS MAKE ANY REPRESENTATIONS OR WARRANTIES, EITHER EXPRESSED OR 
IMPLIED, WITH RESPECT TO THE DISKS OR THE PROGRAMS, INCLUDING BUT NOT LIMITED TO,
THE QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE
OF THE DISKS OR THE PROGRAMS.    IN NO EVENT SHALL SOFTECH MULTIMEDIA, INC. OR THE 
SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES ARISING OUT THE USE OF OR INABILITY TO USE THE DISKS OR PROGRAMS FOR 
ANY LOSS OR DAMAGE OF ANY NATURE CAUSED TO ANY PERSON OR PROPERTY AS A 
RESULT OF THE USE OF THE DISKS OR THE PROGRAMS, EVEN IF SOFTECH MULTIMEDIA, INC. 
OR THE SUPPLIERS HAVE BEEN SPECIFICALLY ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.    NEITHER SOFTECH MULTIMEDIA, INC. NOR THE SUPPLIERS ARE RESPONSIBLE 
FOR ANY COSTS INCLUDING, BUT NOT LIMITED TO, THOSE INCURRED AS A RESULT OF LOST 
PROFITS OR REVENUE, LOSS OF USE OF THE DISKS OR THE PROGRAMS, LOSS OF DATA, THE 
COSTS OF RECOVERING SOFTWARE OR DATA, OR THIRD PARTY CLAIMS.    IN NO EVENT WILL 
SOFTECH MULTIMEDIA, INC. OR THE SUPPLIERS LIABILITY FOR ANY DAMAGES TO YOU OR 
ANY OTHER PARTY EVER EXCEED THE PRICE OF THE SOFTWARE.    NO SALES PERSON OR 
OTHER REPRESENTATIVE OF ANY PARTY INVOLVED IN DISTRIBUTION OF THE DISKS IS 
AUTHORIZED TO MAKE ANY MODIFICATIONS OR ADDITIONS TO THIS LIMITED WARRANTY.

Some states do not allow the exclusion or limitation of implied warranties or limitation of liability 
for incidental or consequential damages, so the above limitation or exclusion may not apply to 
you.

SofTech Multimedia, Inc. retains all rights not expressly granted.    Nothing in this license 
constitutes a waiver of the rights of SofTech Multimedia, Inc. under the U.S. Copyright Act or 
any other Federal or State law, international treaty, or foreign law.



Credits and Contributions

We would like to thank the following individuals for their help and expertise in getting this 
product together. Without their contributions this product would not have been possible:

 Daryl Pietrocarlo- For his constant devotion as the senior software engineer and lead 
programmer and implementing new and challenging ideas.

 Robert H. Mowery III- Making numerous revisions, development suggestions, the newly 
revised help, and marketing efforts.

 Sten McKenzie- The great job with our Piano Professor(tm) Logo    and for the Main 
Menu graphics.

 Fred Costello- For reviewing the product and providing his music expertise, advice, and 
guidance.

 Edith Lawson- For her devotion in writing the users manual and other behind the scene 
efforts.

 Todd Foster- For his art skills in developing the registration control.

 Melissa Rados- For her help and flair with the red pen in correcting our mistakes in all 
our documentation and the other behind the scenes efforts.

 Kevin Brinsmaid- for his dedication to developing a full proof installation and the other 
behind the scenes efforts.

We use INSTALLShield to build all of our installation programs and thank the people at Stirling 
Technologies, Inc. for all their help.    Stirling has made a very fine product and we recommend 
INSTALLShield to anyone producing software.    INSTALLShield has made our lives easier by 
providing a complete setup for building installation programs and hopefully makes your life 
easier by providing a simple and intuitive means of getting your software up and running.Stirling
Technologies, Inc. may be reached at (800) 374-4353.



About SofTech Multimedia, Inc.
You are probably wondering a little about our company and the history of our company.    We are
a small, privately owned software development and consulting company.    We have been 
developing applications for clients on a customized basis for about two years now. Our team of 
programming experience dates back about 10 years.    We are in no way a large software 
house, but do hope to grow with your continued support.    We are hoping to continue expanding
our product lines and offering you quality software and low cost.    We have made a commitment
to produce software and sell it for less then $25.00.    We feel that properly engineered software 
products should not cost above that price range.    Most of todays commercial applications are 
proceed ridiculously high due to the large overhead involved in the marketing and advertising.    
We believe in the shareware concept and hope that you do too.    Shareware allows 
programmers such as ourselves to bring quality products to you at the low costs simply because
there is no overhead in advertising and marketing.    Thus we can spend more of the money on 
hiring more talent in the areas of art and programming.      We are members of two trade 
organizations that also believe in the shareware concept.    The organizations are STARand 
ESC.    These trade organizations help us to help you through their efforts in promoting the 
shareware concept.

SofTech Multimedias mission is to help usher in the Multimedia technologies in the professional,
educational, and entertainment areas.    We are achieving these goals by consulting and 
developing software for other companies that will be marketed by those companies and 
developing titles under our own label.

We do provide custom programming services and consulting services both locally, nationally, 
and internationally.    We have consulted to small business and fortune 500 companies.    Should
you be interested in having software developed please feel free to contact us.    If you have any 
suggestions for future product enhancements, new ideas, or anything else that we may be able 
to help with, please feel free to drop us a line.



Authors Note
I am writing this section in an attempt to explain in a non-technical way the reason why I wrote 
this piece of software, and how I think it can help you learn to play the piano.

When I was younger I took piano lessons for approximately 3 months.    During this period I was 
taught to play scales, scales and even more scales.    I was then taught to play a few songs that 
were not very interesting as far as I was concerned.    Shortly afterward, my piano lessons 
ceased, but my interest and admiration for those that could play music (especially on the piano) 
increased more and more.

During the end of my college years, I was fortunate enough to cross paths with a friend of mine 
who could play the piano exceptionally well.    He showed me how to play a few songs that I 
actually recognized, one of which was the beginning of Fur Elise by Ludwig Van Beethoven.    I 
was hooked.    The catch was that in order to play the song I would have to either drive my friend
crazy with nagging questions or learn how to read music.    Obviously, I took the latter path.    

I went to a music store and bought the sheet music to Fur Elise.    The problem was that the only
note I could recognize in the sheet music and actually find on the piano was middle C.    Armed 
with this knowledge, I started counting up or down from middle C to figure out the notes I didnt 
know, and    quickly forgot the next time I saw them in the music.    Attempting to make my 
fingers play the keys was one problem that I knew could be overcome with practice, but I figured
that there had to be a better way to teach myself how to recognize notes.    Herein lies the 
beginning of the Piano Professor.

I started with an extremely simple DOS based program that made notes randomly hop around 
on the staves without giving the note name.    The only way to reveal the name of note was to 
press a special key on the computer keyboard.    So, I would guess the name of the note I saw 
in my head and use the computer as the confirmation.    If I didnt know the name, the computer 
had the answer!    I could sit at my computer and teach myself to read music. Each time I sat 
down and used the program, I would become more and more proficient at guessing the notes.    
I    noticed a great improvement in my playing because I was no longer trying to figure out the 
note while trying to play it.    Now I could concentrate solely on making my fingers play the note.  
The Note Tutor is a representation of this first program, albeit a lot more elegant.    Adding the 
functionality to plug in a MIDI capable keyboard was almost left out of    the first version, but 
after seeing it work, I just couldnt leave it out.    

As my playing became better I found (as did many other musicians) that I could pick up a piece 
of popular music, play the melody with my right hand and play the guitar chords shown above 
the music with my left hand.    This is easier than attempting to read and play all the notes 
usually required in the bass with your left hand.    Once you know a chord, it becomes a position 
rather that 3 or 4 notes.    Even though there is a theory behind the creation of chords, I could 
not always remember the theory or I just wasnt sure if what I was playing was correct.    So I 
wrote the Chord Encyclopedia, which includes most of the major chords found in music, and    I 
refer to it often.

Name that Note was written because I wasnt born with the gift of being able to name a note 
simply by hearing the sound.    I wrote this screen to help those of us who would like to get 
better at being able to recognize notes just by the sound.    I think this screen has already helped



me, I hope it can help you.

The Key Signature screen will help you to recognize the different keys that music is written in.    
By knowing what key a piece of music is in, playing along with music or playing by ear definitely 
comes easier.    

The Keyboard screen was written to guide those that have never had any real experience with a
piano, and hopefully, will be enough to get you started with the Piano Professor.

If you have read this far, I am grateful.    I hope that this program can be of some use to you or 
someone you know.    I wrote it because I love to play the piano and would like to take some of 
the fear out of learning to play it.    Playing the piano does not come easy, you still have to 
practice.    I am by no means an expert in the area, most are better than I.    For those who can 
play the piano, I hope this proves a useful tool.    For those just learning, it is my desire that the 
Piano Professor can help you to learn faster and ease the discouragement that can be 
accompanied when learning to play.    Enjoy.

Daryl Pietrocarlo -- Rochester, New York USA




